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i) Pre-requisites: 

Grab tortoiseSVN from the link below: 

http://tortoisesvn.net/downloads.html 

Note: Grab the correct version. Meaning that if you have 32-bit Windows grab the 32-bit installer and 
vice versa. To find out your windows “bit” version click the windows icon and right-click my 
computer>properties. You will be able to see the specs of your OS. 

 

 

 

 

 



 

 

Once you have installed tortoiseSVN, you will be prompted to restart your PC, so make sure to restart 
your computer once it prompts you to. 

Once your PC has restarted, when you right click, you will see a new addon that lets you checkout svn 
with tortoiseSVN. 

 

Now, we will checkout a Ragnarok Server Revision. This is up to you. The options below are available 
to you: 

eAthena (No Third Jobs Currently):  

SVN Repository: http://eathena-project.googlecode.com/svn/trunk/ 
SVN Changes: http://code.google.com/p/eathena-project/source/list 

3CeAM (Old RO Mechanics - Has working Third Jobs):  

SVN Repository: http://3ceam.googlecode.com/svn/trunk/ 
SVN Changes: http://code.google.com/p/3ceam/updates/list 

ReAM (Renewal Mechanics –Third Jobs Buggy but there are still updates going on):  

SVN Repository: http://ream-project.googlecode.com/svn/ 
SVN Changes: http://code.google.com/p/ream-project/updates/list 
 
rAthena (Starting Third Jobs/Renewal/Non-Renewal Mechanics) [Some bugs and still working on 
implementing third jobs fully] || [May or may not support TXT in the future…] 
 
SVN Repository: https://rathena.svn.sourceforge.net/svnroot/rathena/trunk/ 
SVN Changes: http://sourceforge.net/apps/trac/rathena/timeline 



 

Eidolon Package (Renewal Mechanics – Has working Third Jobs|200 Customs (Optional) |Clean Src) 
Paid: PM me on the forums (http://www.supportmii.com/board) or message me on Hotmail 
(zbui543@hotmail.com)  

 

Once you have chosen which svn to checkout, copy the “SVN REPOSITORY” link you have chosen and 
create a new folder on your desktop and name it whatever you want. For this tutorial, I will just use 
the default “New Folder” on my desktop and checkout eAthena. Right-click the newly created folder 
and click “svn checkout” and hit “ok”. It will start to download the branch of the server you have 
chosen. Once it finished press “ok” to close the window and now you have your server files inside 
your newly created folder. 

 

Let’s switch gears and move over to the Client Side pre-requisites. You will need Ragray and install it 
into a clean folder. Below are some alternatives to Ragray which will include everything you need for 
a clean RO folder. 

Ragray Renewal - http://ragray.net/ 
�From the website, there are many alternatives to download Ragray. Either through Torrents or 
Direct Download via Rapidshare/FileServe. 

Once you have installed Ragray, patch fully by clicking on the “ragray.exe”.  

ii) Setting up your server: 

Now, it’s time to install MYSQL Server and MYSQL GUI tools. These programs can be downloaded and 
installed by the links below: 

MYSQL SERVER - http://www.supportmii.com/ro1/tools/mysql-5.1.46-win32.msi 

MYSQL GUI TOOLS - http://www.supportmii.com/ro1/tools/mysql-gui-tools-5.0-r17-
win32.msi 

Now, we will install these packages to get it working with our server files.  

Install MYSQL 5.1.46 
Click Next 
Click Typical 
Click Next 
Click Install 
Choose Skip Sign-Up and click Next 



 

Uncheck Register the MYSQL Server now 
Make sure Configure the MYSQL Server now is checked 
Click Finish 

Now, you can either choose Detailed Configuration or Standard Configuration, which is up to you but 
if you are unsure, just choose Standard Configuration and click Next. 

 

In Service Name: Pick MYSQL5 and click Next 

 

Just enter the password you wish to use for root and MAKE SURE YOU REMEMBER IT!  
Click Next 



 

 

Just click the Execute button and when done, just click Finish. 

Now Install MYSQL GUI TOOLS. 

Click Next 
Accept Terms and click Next 
Click Next 
Click Complete and click Next 
Click Install 
Click Finish 

Now, start MYSQL Administrator and it will prompt a window 
Fill in Host Name, Username, and Password 
Leave the other fields blank 
It should look like the following: 

Stored Connection: (Just Leave Empty) 
Server Host: localhost 
Username: root 
Password: (Enter the password we created for root | The one I said not to forget!) 
Port: 3306 

 

 



 

 

 

 

Click OK and you should be in MYSQL Administrator now. 
Go to User Administration and Click Add New User and enter this: 

MYSQL User: ragnarok 
Password: ragnarok 
Confirm Password: ragnarok 

 

Note: These are default settings for easy setup which I will be using. If you wish to be a little 
more secure, change these to different credentials and remember to change them since I will 
be using ragnarok credentials for this entire guide. 



 

When you are done, then just click Apply changes and exit MYSQL Administrator. 
Start MYSQL Query Browser and it will prompt a window that looks like MYSQL Administrator 
except there is a new field called Default Scheme. It should look like this: 

 

Stored Connection: (Just leave it empty) 
Server Host: localhost 
Username: root 
Password: (Enter the password we created before for root) 
Default Schema: ragnarok 
Port: 3306 

When you are in MYSQL Query Browser, make sure the ragnarok schema is bold by double clicking 
on it. Go to menu, click File and choose Open Script… 
We need to execute “main.sql” and logs.sql, so look for the main.sql, which should be in the sql-files 
folder in your server files you checked out. 
Pick main.sql and click open. 
Make sure the ragnarok scheme is in bold, if not double click on it to make it bold. 
Click the Green Execute Icon to the upper right to execute it into the ragnarok db 

Now, we need to create log database by right-click somewhere within the table where the databases 
are and choose “Create New Schema and type in log and click OK. 
Double click on the log database to make it bold 
Go to menu, click File>Open Script… 
Open logs.sql and click the execute button to make entries under the log db. 

Next, double click the ragnarok database and expand it to see all the tables. 
Look for login table and double click it, and double click it again to expand it inside the Query 
Browser 
Near the bottom, click on the edit button, so we can edit the rows 
For userid: and user_pass:, we will be using ragnarok/ragnarok, if you wish to be more secure then 
change these credentials to something else, and make sure to remember them so we can edit the 
server files with them 



 

 

 

 

 



 

 
 

Additional SQL Injections & (If encounter login issues and see weird stuff in the map console): 
 
3CeAM | Additional Injections: 

Item_db.sql 
Item_db2.sql 
mob_db.sql 
mob_db2.sql 
upgrade_svn14672.sql 
upgrade_svn14700.sql 
upgrade_svn14797.sql 
3CeAM_svn320.sql 
3CeAM_svn491.sql 
3CeAM_svn506.sql 
3CeAM_svn519.sql 
3CeAM_svn_elemental.sql 
3CeAM_svn_update_item_db2.sql 
 

eAthena/ ReAM |Additonal Injections: 

Item_db.sql 
Item_db2.sql 
mob_db.sql 
mob_db2.sql 
upgrade_svn14672.sql 
upgrade_svn14700.sql 
upgrade_svn14797.sql 

Note: If you see an error, saying duplicated entry in the Query Browser then ignore it since that 
means that the sql-file is already in the database. 

Once that is done we will switch back to MYSQL Administrator 
In the menu of Query Browser, click Tools>MYSQL Administrator 
Go to User Administration and click the ragnarok user. 



 

Now, go to Schema Privileges tab and click once on the ragnarok database/schema and click the “<<” 
button and then click Apply changes. Do the same with the log database/schema. 

 

We are now done setting MYSQL server and our database. We will now be configuring our ragnarok 
server files to be able to connect to the MYSQL server. This is where we will need those credentials 
for the user/pass and as well as the database/schema name, and also the login table credentials. 

 

Head to the server files you checked out and double click on conf/map_athena.conf [Edit with 
notepad] 
 
map_athena.conf: 
 

 



 

 

Now open char_athena.conf and we will do the same as we did for the “map_athena” 

 

Now open up iter_athena.conf and we will configure settings to connect to MYSQL 

 

Once finished, we will need to know how to recompile. 
 

 



 

iii) Compiling (Windows) 

Below are some options for you to compile under Windows. Mainly I will be using Visual Studio 
2010. I will not bother using cygwin to compile our server files. 

Visual Studio 2010 Trial – http://www.microsoft.com/visualstudio/en-us/try 

Visual Studio 2010 Ultimate Unlocked – http://www.mediafire.com/?x71bzq7dibfer 

Once you have installed the whole package fully, restart your PC to finish the installing changes. 

Once restarted, in your server files, click on “solution file 10” and the solution will open in Visual 
Studio 2010. However, if you use my special complete modified packages then use “solution file 9” (In 
this case, it isn’t released unless I get some donations to host a vps for compiling test/stability.) 

Visual Studio Compiling: 
 
Open your solution file up with Visual Studio and follow the pictures. 
[Right Click for the options] 

 
 

 
 



 

 
 
 

If you are using my compile, it is normal to see 
 
========== Build: 11 succeeded, 1 failed, 0 up-to-date, 0 skipped ========== 
 
But in normal cases, you should see all of the solution files all succeed and compile with no errors 
 
runserver [to run txt based server] 
runserver-sql [to run sql based server - You need to configure server side settings though] 

 

iv) Client Side Settings 

There are different ways to diff your client for your server. First we must make sure you are using the 
right client for your server. In your server files folder, navigate to src>common>mmo.h and open it in 
visual studio 2010. You must have a client that corresponds with the packetver. Also for clientside 
you must use lub settings that corresponds to your packetver as well. For simplicity, we will be using 
client date 20110118. So in mmo.h make sure the packetver is set to 20110118 and recompile to 
save your settings. Make sure in src>map>clif.h, the packet is also set at 26 as well and recompile. 
Finally, make sure db>packet.db is set to 26. 



 

 

 



 

 

 

 

NOTE: Any changes to source code “src” you must recompile with Visual Studio 2010. 

The easiest tool to diff clients is to use Shinyo’s Diff Patcher. 

Shinyo Diff Patcher – http://www.eathena.ws/board/index.php?showtopic=269382&hl= 

Checkout out the diff patcher by copying the link below: 
 
https://subversion.assembla.com/svn/weetools/trunk/ShinsDiffPatcher/ 



 

And creating a new folder on your desktop 
Right Click and svn checkout 
Make sure the link you copied is in the top box 
Click Ok 

Now, for this tutorial we will be using clients 2010-12-28 and up. For Shin’s Diff Patcher, only the 
client is needed, and not the diff file. Clients can be downloaded from the link below. 

Renewal Clients - https://subversion.assembla.com/svn/weetools/clients/ 

Now, place the client inside the diff patcher folder like so: 

 

Then, double click on “ShinsDiffPatcher” 
 



 

 

 

Under Select Patch Engine, Select, WeeDiffGenerator v1.0.2 

 

For the Source executable row, hit select 
Open up the 2010-12-28aRagexeRE client 
It will load all the diffs in the window 
We will be able to customize settings now 
Select Yes to auto select patches when the windows comes up 



 

  

The following patches are what I recommend for GRF/DATA type servers. Clients that are made must 
be executed in a clean RO folder dedicated for your server ONLY to avoid any conflicts. Select Patch 
It! When you are done adding your diffs to patch your client. 

Type : [UI] 

Group :  

Name : Allow Chat Flood 

Description : Allows you to repeat the same line n-times. 

Value : 30 

Note :  

PL Author : Shinryo 

==================== 

Type : [Fix] 

Group :  

Name : Allow Multiple Windows 

Description : Allows your to start more than one client at the same time. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [Fix] 



 

Group :  

Name : Always Call SelectKoreaClientInfo() 

Description : Calls SelectKoreaClientInfo() always before SelectClientInfo() allowing you to use 
features that would be only visible on korean service type. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [Fix] 

Group :  

Name : Chat @-Bug 

Description : Allows you to use the @ symbol without changing shortcuts. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Custom Window Title 

Description : Changes the window title to a custom one. 

Value : chronicdestiny.xlcnetwork.com - SupportMii 

Note :  

PL Author : Shinryo 

==================== 

Type : [Fix] 

Group :  

Name : Disable 1rag1 & 1sak1 

Description : Allows you to start the client without 1rag1 & 1sak1 as command line parameters. 

Value :  

Note : Recommended 



 

PL Author : Shinryo 

==================== 

Type : [Fix] 

Group :  

Name : Disable Hallucination Wavy Screen 

Description : Tells the client to ignore the wavy screen effect. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [Fix] 

Group :  

Name : Disable HShield 

Description : Prevents AhnLabs HackShield from beeing loaded during client start up. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [Add] 

Group :  

Name : Disable Nagle Algorithm 

Description : The Nagle Algorithm delays packet transfer by combining small packets into a large one 
reducing bandwidth while increasing latency. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [Fix] 

Group :  

Name : Disable RagexeRE Filename Check 



 

Description : Allows you to rename the executable to whatever you want. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Disable Swear Filter 

Description : Allows you to skip the swear prevention function. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [Add] 

Group :  

Name : Enable 127 Hairstyles 

Description : Allows you to use more than the default max. 27 hairstyles. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Enable Aura Over Level 99 And Level 150 

Description : Allows the client to display standard auras over level 99 and 3rd class auras over level 
150. 

Value :  

Note :  

PL Author : Shinryo 

==================== 



 

Type : [Add] 

Group :  

Name : Enable DNS Support 

Description : Allows the client to read fully-qualified host names inside the clientinfo xml file. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [Data] 

Group :  

Name : Enable Multiple GRFs 

Description : Tells the client to load grf files based on a list within data.ini. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Enable Title Bar Menu 

Description : Changes the window style to display all buttons (minimize, maximize, close) and the 
icon in the title bar. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Enforce Official Login Background 

Description : Forces the client to use kRO login backgrounds on all langtypes. 

Value :  



 

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Extended Chat Box 

Description : Increases max input chars of main/battle chat box from 70 to 88. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Extended Chat Room Box 

Description : Increases max input chars of chat room boxes from 70 to 88. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Extended PM Box 

Description : Increases max input chars of PM boxes from 70 to 88. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [Fix] 

Group :  

Name : HKLM to HKCU 



 

Description : Uses the windows registry HKEY_CURRENT_USER instead of HKEY_LOCAL_MACHINE to 
save registry entries. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Ignore Missing File Errors 

Description : Prevents the client from displaying error messages about missing files. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Ignore Missing Palette Errors 

Description : Prevents the client from displaying error messages about missing palettes. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [Data] 

Group :  

Name : Increase Headgear View ID 

Description : Allows you to increase the maximal view id used in LUA script files. 

Value : 3000 

Note :  

PL Author : Shinryo 

==================== 



 

Type : [UI] 

Group :  

Name : Increase Zoom Out 75% 

Description : Allows you to zoom out 75% further from the ground. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [Data] 

Group :  

Name : Load LUA Before LUB 

Description : Allows you to load LUA files before LUB files are being loaded. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Only First Login Background 

Description : Displays always the first login background. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [Data] 

Group :  

Name : Read Data Folder First 

Description : Attempts to read files inside the data folder prior to those in grf archives. 

Value :  

Note : Recommended 



 

PL Author : Shinryo 

==================== 

Type : [Data] 

Group :  

Name : Read msgstringtable.txt 

Description : Allows you to read the message string table on all languages. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [Data] 

Group :  

Name : Read questid2display.txt 

Description : Allows you to read the quest table on all languages. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Remove Gravity Ads 

Description : Removes advertisements from the login interface. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Remove Gravity Logo 

Description : Removes gravitys logo from the login interface. 



 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [Fix] 

Group :  

Name : Restore Login Window 

Description : Tells the client to use the old login interface prior to Gravitys new token based login 
system. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Skip License Screen 

Description : Jumps directly to the login interface without displaying the license screen. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Skip Resurrection Buttons 

Description : Skips the ressurection button whenever you die or use Token of Siegfried. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 



 

Group :  

Name : Skip Service Select 

Description : Jumps directly to the login interface without asking to select a service. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Translate Client Into English 

Description : Translates hardcoded text inside the client into english. 

Value :  

Note : Recommended 

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Use Arial On All Langtypes 

Description : Changes the default font to Arial on all language types. 

Value :  

Note :  

PL Author : Shinryo 

==================== 

Type : [UI] 

Group :  

Name : Use Ragnarok Icon 

Description : Tells the client to use the default Ragnarok icon. 

Value :  

Note :  

PL Author : Shinryo 



 

Open the data folder and right-click and edit the clientinfo.xml 

 

To test it out on your test server, leave the settings as it is. If you are putting your server online, 
replace localhost/127.0.0.1 with your WAN IP. This will be discussed later in the guide. 

For simplicity the correct lua files have been placed in the JUDAS AIO PACKAGE for the 20110118 
client. Leaving files in lua format will be easier to test your customs and make changes easier. In 
essence, it will work out of the box. 

Latest Lua files can be accessed at the link below: 

Latest Lua – http://svn6.assembla.com/svn/ClientSide/Lua_Project/ 

Note: Lua Rev at the moment is 125, if any changes you must update it by checking out the branch as 
we did before. But in this case copy the link above and create a new folder and check out using that 
info! 

v) Server Side Settings 
This section will focus on the settings you can make to customize your server. The first few changes 

we will make will be in the source files so it will make things easier when we modify files outside 
the src files. REMEMEBER ANY SRC CHANGES MEANS WE HAVE TO COMPILE USING VISUAL 
STUDIO 2010. 

The first src file we will edit is the mmo.h. Open the file in visual studio. mmo.h is located in server 
files>src>common.  

If you are using a default revision, you will find this 
 
“#define MAX_CHARS 9”  
 
This means that you will enable 9 available character slots that can be made by your players. You can 
increase it to any amount of slots you want as long as it is a multiple of 3. For example, 



 

9,12,15,18,21,24,27,30…..” 
Input your value and save your changes. 
Next, 
 
#define MAX_STORAGE 600 
#define MAX_GUILD_STORAGE 600 

These values should ideally stay the same to avoid any overflow errors to your consoles. If you had 
enabled 1000 storage/gstorage and reduced it you would lose your player’s items. 
 
#define MAX_PARTY 12 
 
Put in a value if you wish to increase the amount of people in the party. 
 
#define MAX_FRIENDS 40 
 
Put in a value if you wish to increase the amount of friends that you can make. 
Now save. 
Close mmo.h and open src>map>map.h 
 
#define MAX_LEVEL 99 
 
Change this value to 1000 so anytime you wish to change levels, you will only have to make changes 
to the exp.txt file.  
 
Note: In the db folder, make sure to rename the original exp.txt to exp_old.txt. 
Rename exp2.txt to exp.txt. 
This change will allow us to make level changes from 1-1000, so we can choose easier! 
 
#define MAX_VENDING 12 
 
Changing this value will allow you to vend more than 12 items if you wish. 
Save changes and open src>map>pet.h 
 
#define MAX_PET_DB 300 
 
Change the value to 900 so if you wish to add any custom pets, you won’t have console errors. 
Save changes and open src>map>mob.h 
 
#define MAX_MOB_DB 4000 
 
Change this value to 10000, so any custom monsters, or mobs you add will still be able to be read by 
the console/server. 
Save changes. And we are done with source edits for now. So that means RECOMPILE YOUR SERVER 
WITH VISUAL STUDIO 2010. 

 

 

 

 
 



 

vi) Custom Window Title 
REFER TO SECTION – CLIENT SIDE SETTINGS (USING SHINYO DIFF PATCHER) 

From the diff patcher, you will be able to input your own custom title. 

 

vii) Custom Login Screen 
Usually splitting your image into 12 individual pieces can be confusing to new-comers, and even the 

php file to extract it can also be confusing. So the tool below will be able to cut your login screen in 
12 pieces with ease.  

1024x768 Login Screen Splitter – 
http://www.supportmii.com/ro1/tools/ROLSG%5b1024x768%5d.exe 

 

Note: Image must be 1024x768, usually better quality is when there is solid color and when you cut the 
pieces, make sure you cut each time in all 4 settings, which will override any default Gravity Screens! 

Additional Notes (If not yet specified): 
 
“Anyway load your JPG or any other format with this tool. The size should be exactly 1024×768 for this to 
work. Anyways, after it is loaded, hit “Convert” and select “1″, and then you will see 12 parts of your 
images sliced. Copy those files into the root of “texture/À¯ÀúÀÎÅÍÆäÀÌ½º/” folder and you will see your 
custom login screen when you load up your client. 

NOTE: Some users reported that if you don’t use a solid color, the image will become distorted in such a 

way that the image quality is loss. Also, make sure you diff your client with “Only use First Login 

Background” and “Enforce Official Login Background. If options are not available then the above saying 

that cutting the 12 pieces under each option (1,2,3,4) will usually work as well” 



 

viiiCustom RO Icon 
Note:This section includes a PDF and tools to create a new Icon image for your diffed client. 

Custom RO Icon + Guide - http://www.supportmii.com/ro1/tools/RESHACKER%20-
%20ICON_BUI.7z 

Custom RO Icon Images to Use – 
http://www.supportmii.com/ro1/tools/Custom%20Icons.7z 
 

xiAdding GM’s to clientinfo.xml 
This will show you how to add your GM’s to the clientinfo to make them show up with GM clothes 
and a Yellow Name/Chat. 

Open up clientinfo.xml in the data folder with notepad 

 

Then once finished, you should have a GM account, with GM clothes and Yellow Text. And at the 
moment, there is no way to make a GM with yellow text without GM clothes. 

Note: You must remember to distribute/patch this file so other players can see the GM changes. 

 

 

 

 



 

X Making a GM account SQL 
Open up MYSQL Query Browser, and enter your credentials to access your ragnarok database 

Double click ragnarok 
Double click login table 
Double click login table again to expand it into the Query Browser 
Create a New Account by clicking the edit button 
Right-Click on a new Row and click add Row 

 

Input “25000000” and press Enter 
Double click the userid and user_pass in the row and enter your user/password 
Click Apply changes to save our settings 
 

 



 

To make this account with GM powers/commands, click the edit button, and in the level column put 
in the level you want. For example, put in 99 for all GM powers/commands. Click on save changes to 
save your settings.  

 

To make this account have GM clothes and Yellow text, remember/copy down the Account ID, which 
in this case is the “25000000”. 

Now return to your clientinfo.xml and input the Account ID like show below. 

 
 



 

Xi Compiling GRF 
This section will focus on compiling your own grf to work for your server. Ideally, your data folder 
will be the one that will be turned into the GRF file. Below is a separate guide and tools to build your 
own server’s grf file. 

Gryff Builder - http://www.supportmii.com/ro1/tools/gryff.7z 

Gryff PDF - http://www.supportmii.com/ro1/tools/Compile%20GRF.pdf 

Usually to make changes to your GRF, one will have to patch in changes. This will be explained later 
in the tutorial. 

Xii Setup Patcher (Thor | Using a cheap webhost) 
Usually a free webhost would work, but they are limited on how much space and bandwidth you can 
take up. It causes eA boards and other people problems when you are using a free webhost which might 
now support patching files. So for this guide, I will be using a cheap webhost to set up the patcher. 
 
Webhost – http://www.hostbig.com 
 
Download Thor Patcher from the link below: 
 
Thor Patcher - http://thor.aeomin.net/Thor_Patcher%5b2.6.1.66%5d.7z 

Extract the contents somewhere on your PC. In my case, I created a folder called Thor, and extracted the 
contents into that folder 

 
 

For this guide, I will be using “hostbig.com” details to fill out the settings for the patcher to be able to 
patch files to my grf. 



 

After paying for hostbig.com, (I did the Exite Plan, and with registering the domain, the total cost is $22 
without any addons) 

After payment, after couple of hours, they will send you your webhosting information. 
You want to scroll down to  
 
#3 FTP – Uploading your website 

The client we will use to connect is Filezilla which can be downloaded below: 

Filezilla Client - http://filezilla-project.org/download.php?type=client 

Go ahead and download and install it. 
After installing it, open the program up 

Enter your credentials in Filezilla 
Host: Host Address, Given in email 
Username: Given in email 
Password: Given in email 

Once connected go to “www” shortcut 
Create a new folder called thor 

 



 

Go inside the folder and create a new folder called patch 
 

 

Now go back to your Thor folder with our patch utilities and navigate to Thor>Web 
Edit plist.txt, and remove the two entries 
Save and close the file. 
Edit notice.html with notepad++ and edit to your liking 
Save and close the file 



 

 

Open up main.ini file 
We will now edit it with our hostbig.com account settings 
Look for this line 

file_url=http://domain.com/patch/data/ 

We will change it so it looks like this (These are my settings…Domain Name is given to you in the email 
they sent) 

file_url=http://supportmii.com/thor/patch/ 

 

 



 

Save and close the file 
Now, drag all the contents in the Thor>Web folder into the filezilla client  
www shortcut>thor folder 

 

Now navigate to your Thor Tools, Thor>Tools 
Open up config.ini 

Find  

RootURL='http://127.0.0.1/patch/' 

Change it to your account settings…Mine would be the following 

RootURL='http://supportmii.com/thor/' 

Find these three 

StatusFile='server.dat' 
DefaultGRF='server.grf' 
ClientEXE='game.exe' 

Change it to the name of your server, and name of client 
 
 



 

StatusFile='test.dat' 
DefaultGRF='mytest.grf' 
ClientEXE='mytest.exe' 

If you wish to add BGM when the user is patching then fine these lines 

[Config:BGM] 
 
Directory= 
 
The Patcher and bgm folder you name has to be in the same directory as each other. 
I will create a new folder on my desktop and call it bgmcust. 
So it will look like this 

[Config:BGM] 
Directory='bgmcust' 
 
The format of the bgms you use have to be mp3 format 

 

Find  

Title='Thor Patcher' 

Change it to the title of your server 

Title='Making a Thor Patcher' 

Finally, find  

URL='http://127.0.0.1/opatch/Notice.html' 



 

And change it to your account settings 

URL='http://supportmii.com/thor/notice.html' 

Now run ConfigEmbeder.exe to compile our patcher 
Browse to the patcher, Thor>Patcher>Thor.exe 
Select it and hit Pack 
In addition, drag the folder “images” from the Thor>Tools directory into your FTP. 

 

We are done for the most part, once you packed your config file test out the Patcher. 



 

 

The next lesion will be making/uploading Patches 

 

 

Xiii Making/Uploading Patches via Thor (GRF) 
You must have changes ready to make a patch. So for example, I created a document called test.txt 

 



 

Now, create a folder on your desktop called “data” 

 

Place the test.txt file inside the data folder.  

 

Note: That when you add files to make patches, they must be in the right structure where you want to 
update your files. Since this is just a test document when we patch it into our grf, it will just go into the 
root of our grf. So to make it clearer, if we wanted to added textures, they would have to go in our data 
folder in the structure data\texture\ À¯ÀúÀÎÅÍÆäÀÌ½º\ 

Now, in the Thor folder we made with all the contents of the package, navigate to Thor>Tools>Thor 
Generator.exe 



 

 

Under Output, click select, and enter an output filename for your patch. 
For this guide, I will call my output filename testing.  
It will have an automatic extension of .thor 
So the complete output filename is testing.thor 

In the box, where it says File, change it to RO-GRF 
In the type in box, enter the name of your server’s GRF 
So if my server’s grf was called Judas 
In the type in box, I would put Judas.grf 

 

Under input, leave Directory selected 
Click the select button and navigate to our data folder 



 

 

 

Click once on the data folder, and press ok. 
Under Compression level, leave the compression on high 
Under options, tick the box called Acsii 
Then click generate. 
Our patch should appear on our desktop called testing.thor 
We have just made our first patch using Thor!!! 

Now, we will begin to upload our patch to our webhost to be patched into our server’s grf file. 

Go back to Filezilla, and go INSIDE the patch directory and upload the testing.thor file 



 

 

Go back in your Filezilla and open up plist.txt 
We will add the patch to this file so when your players open the patcher, it will patch the file 

The format is: 

Patchnumber(space)nameofpatch.thor 



 

 

Close it, and filezilla will ask you to save the file, so please do. 
You are now done! You have uploaded and made your first patch file! 

Test it out by starting your Patcher. 



 

 

If the patch doesn’t work it may be because the file we used is just too trivial.  

Xiv Installing Flux CP (Disable _M/_F) 
We will be using the same webhost to install FluxCP. You can download the Flux CP files here 

Flux CP - http://code.google.com/p/fluxcp/downloads/detail?name=fluxcp-1.0.0.962.rar&can=2&q= 

Create a new directory called “cp” in your ftp 
www shortcut>cp 
Drag the contents of the FluxCP archive into this directory 



 

 

Now go to your Cpanel, the info is given in your email 
Once logged in, scroll down to Software/Services>PHP Configuration 
Click on it 

 

In the drop down box, make sure PHP5 is selected 

 



 

Press update to make the changes. 
Go back to filezilla, and go to the cp>config folder 
Extract the application.php file onto your desktop 
You can do so by dragging the file onto your desktop 

Open the file with notepad++ 
We will now use our credentials to be able to install Flux 

Right now, I will be filling it in with my info as an example 

Find: 'ServerAddress'        => 'localhost', 

To: 'ServerAddress'        => 'http://supportmii.com', 

Find: 'BaseURI'              => '', 

To: 'BaseURI'              => '/cp', 

Find: InstallerPassword'    => 'secretpassword', 

To: InstallerPassword'    => 'thatwaseasy', 

Note: Make sure this password is secure so people won’t be able to mess up your CP 

Find: 'SiteTitle'            => 'Flux Control Panel', 

To: 'SiteTitle'            => 'My First Control Panel', 

 



 

These settings are good for now, we can update it anytime we want by just making changes and when 
asked to update just press update via the CP installer. 
Now save the file and close it 
Drag the file back into the cp>config folder and say yes to overwrite when asked 
 
Now we have to drag cp>config>servers.php onto our desktop 
Open the file with notepad++ 

Find: 'ServerName'     => 'FluxRO', 

To: 'ServerName'     => 'SupportMiiRO', 

We will now setup the rest of the file using our cpanel info 
This information again is #2 – Master Account information 
IP Address, Username, and Password 
 
Now before doing this, go back to your cpanel and go under the Databases 
Select MySQL Databases 

 

I will now create a new database called ragnarok in this case the prefix is support_ragnarok 
Click create database 

Once done, go back to cpanel and go under the Databases and Select phpMyAdmin 
It will open a new page 
 

 

Click on our new database “support_ragnarok” 
Now click the import tab 



 

 

 

We will now import some sql-files. 
Go to your server files>sql-files and we will import the following 

Main.sql 

Click Browse, and click on server files>sql-files>main.sql 
And click on Go to import the files into our database 

And so on…Refer to section 2 “ii” to see the additional sql files to import and the other required sql files 
Once finished head back to the servers.php file to fill in our details 
 
Again, replace Hostname with the IP Address of your domain 
Replace Username with the username of your domain 
Replace Password with the password of your domain 
Replace database with the name of our database. (In this case, remember we created a new mysql 
database…So mine would be supportm_ragnarok. 

Scroll down a bit to do it a second time… 
Under / / Login server configuration. 
Replace the 'Address'  => '127.0.0.1', with the IP of the domain again 
 
Find 'UseMD5'   => true, 

Change to: 'UseMD5'   => false, 
Replace 'ServerName'    => 'FluxRO', with name of your server 
To: 'ServerName'    => 'SupportMii', 

We can change the rest later if you wish. Right now we have everything working for the server to run and 
register. 
Now save the close the file 
Drag the file back to filezilla and overwrite the file when asked to 

In your browser, go to your domain name 
In my case it would be 



 

http://supportmii.com/cp 

Which will bring up the installation page 

 

Enter the secret password you chose from application.php file 
and press Authenticate 

We will be presented with this screen: 

 

Under Alternative MySQL username/password 
Enter the Username and Password…Again use the info from the Master Account Information 

Press Update to install the CP… 

You may be presented by this screen 



 

 

To show the errors…go to cp>config>error.php 
Drag it on to the desktop 
Open with notepad++ 
Change this line: $showExceptions  = false; 
To: $showExceptions  = true; 
Drag back to filezilla, and refresh the browser to be able to see what is erroring us. 

You will probably see PDO errors… 
Anyway, go back to cpanel>Mysql Databases 
Scroll down to “Mysql Users” 
We want to add a New User 

For this case, I will add a username called root 
So in my case, it will be support_root 
Input a password and make sure to remember it… 
I’m just going to use root lol… 
Create the user… 
 
Once added, scroll to the bottom again to see this section “Add Users to database” 
Make sure your user you made is selected, and the database is selected…the one we made earlier. 
Click Add 



 

 

 

Click on All Privileges, and hit make changes to save it. Now, go back and edit the servers.php 
 
Go back to these settings: (Use localhost instead of your domain ip) 
Username would be the user you created 
Password would be the password for the user you created 
Database would be the database we created in mysql database 

'Hostname'   => 'localhost', 

   'Username'   => 'supportm_root', 

   'Password'   => 'root', 

   'Database'   => 'supportm_ragnarok', 

Do the same below. 

Like so: 



 

 

Save it and close it. 
Drag the file back into filezilla and overwrite if asked. 
Refresh the webbrowser to fix the problem! 
Oh..make sure to change the settings in error.php back to false and drag it back to filezilla to save the 
changes 

 



 

The rest is self-explainatory… You can edit the message by going to that directory in our filezilla, and 
opening it via notepad++ to change it. 
If any of the tabs error, it means you didn’t execute the needed sql-files like item_db/mob_db sql files. 
 
You will notice the Who’s Online you will have to change the settings in servers.php to show online when 
the server is online. You would replace it with your server’s IP 

// Login server configuration. 
'Address'  => 'localhost', 
 
'CharServer'    => array( 
'Address'   => '127.0.0.1', 

'MapServer'     => array( 
'Address'   => '127.0.0.1', 
 
So again, you would replace the 127.0.0.1 with the WAN ip or the vps ip. Once done, when the server is 
online it will show green. 
If when you put in your vps ip and it is offline, then check with your webhost to see if the necessary ports 
are open…5121,6121,6900 

If hosting from home, and using the webhost as a database for mysql/cp, then forward ports by going to  

http://portforward.com/english/routers/port_forwarding/routerindex.htm 

Select your router…select the game, and follow directions 
Brand such as Linux, netgear…etc 
 

 

As you can see, you would put Login, TCP/UDP/Login Port/Lan IP 
Lan IP changes so it is not a good idea to host from home… 
Lap IP found by cmd>ipconfig 

 

To disable _M/_F register go to sever files>conf>login_athena.conf 



 

Find: 
 // Can you use _M/_F to make new accounts on the server? 
new_account: yes 
 

Change To:  
new_account: no 

You should be all set, being able to register from the control panel and refusing to register via _M/_F 

Go back to your cPanel and select phpmyadmin, and select your ragnarok database 
Scroll down and select login (left hand side) 
 
You will see 

 

You see the char_athena and map_athena is set to s1/p1. 
So right now I’m going to leave it like this for ease. 
For secure, Press the pencil to edit it and change the userid and user_pass 
Once changing s1/p1 press go to save changes 
Change the values in the char_athena and map_athena conf files. 

 

Now, open up server files>conf>inter.athena.conf so we can input our credentials to connec to the mysql. 
This is needed only if you decide not to host on a home based computer. Meaning your MYSQL is being 
hosted on cPanel. So there are two ways using a webhost or using a webhost. Most preferably is using the 
webhost. So don’t get confused on the previous tutorial on setting mysql on homebase. 

Find:  
// Global SQL settings 
Now change your configurations to look like the following: (replace with your values) 

sql.db_hostname: domain ip given 
sql.db_port: 3306 
sql.db_username: userwecreated 



 

sql.db_password: passforuserwecreated 
sql.db_database: databasewecreated 
sql.codepage: 

Do the same for the two below since they are exactly the same… 

// MySQL Log SQL Database 

log_db_ip: domain ip given 
log_db_port: 3306 
log_db_id: userwecreated 
log_db_pw: passforuserwecreated 
log_db_db: databasewecreated 
log_codepage: 
 

Finally head back to cpanel>Databases>Remote Mysql 
Input your outgoing IP 
Found by going to: 

http://www.whatismyip.com/ 

Enter the ip in the box  and add host…We should now be able to start our SQL consoles and connect to 
our webhost/mysql database 

Done…We have just made our server online SQL using a webhost with mysql…creating databases and 
installation fluxCP successfully. You have also learned debugging issues for flux as well. 

Oh..one more thing to add icons and such…download them here 
 
FluxCP Icons Items - http://code.google.com/p/fluxcp/downloads/list 

 

 

Xv Making your Server Online |Port Forwarding| 

Refer to Section Xvi 

 

 

Xvi Troubleshooting 

Incompatible lua files, char info errors – You must have lua files corresponding to 
your client date, and not anything below it. 

 
Setup.exe pops up – You applied the HKLM to HKCU diff patch…Download the 
patched setup.exe here (Rename it setup.exe) and overwrite the original 



 

Patched Setup.exe - 
http://svn6.assembla.com/svn/ClientSide/Diff_Project/HKCU_Setup/Setup_patche
d.exe 

 
Client won’t start  - Need squirrel files or bad syntax. Download the renewal data 
folder from the previous sections. If one of your text files such as 
displaynametable.txt is missing a # or funny syntax then the client will fail to open. 
A long way to debug is to back up your files, and get a fresh data folder and see if 
that works…Slowly paste files back in to see what file is causing it. 

 
Accname/accessoryid error messages – If you see an error, it will show what line 
the error is from. Open the each lua file and search for that line…If you use 
notepad++ do ctrl+g and enter the line the error tells you. You look to see if you 
messed up on the syntax. Look carefully, if you still can’t find it, post support on eA 
or email me. 

Black screen, but sound - update drivers, try different client. Trying a different 
patched client usually works. Some diff options may cause some computers not to 
see anything. 

Can’t login to server - port forward 6900,6121,5121, allow firewall settings for your 
consoles. 

Mysql settings, console won’t start – Open logserv-sql.bat…not logserv-sql.exe so we 
can see the full error. If there is anything refer to loginlog, then check your 
credentials for mysql and your char/map conf files as well as your inter.conf 

 
Settings won’t save, can’t see any messages - /nm /nm2, will save in data folder 
Make sure the client reads data folder, you can do it…you diffed thte client. The 
settings will be saved in the data folder now 

 
Tabs are gibberish - double click to change them, keyboard on side icon for settings. 
Settings will be saved in data folder 
 
Hotkeys don’t align - get older lub files, or keep updated with me for fixes. Usually 
test out diff clients with using lub files or load lua before lub and see if that fixes it. 

Submit more error reports to keep this guide updated…Email me. 

 

 

 



 

Xvii Adding Custom Auras 
Trans Job Custom Aura Demo - 
http://www.supportmii.com/ro1/tools/Trans%20Job%20Custom%20Aura%20-
%20Demo.7z 

3rd Job Custom Aura Demo - 
http://www.supportmii.com/ro1/tools/3rd%20Job%20Custom%20Aura%20-
%20Demo.7z 

Custom Aura PDF - 
http://www.supportmii.com/ro1/tools/Add%20Custom%20Aura_BUI.pdf 

Notes: ~ Forgot to mention that the “emp shock.tga” file is the one that shoots out of the aura and also 
is used as the “/aura” ~ 

~ The 3rd Job Custom Aura by “shadowe” is in the Demo Package and is much cleaner than the 
default one which was annoying~ 

~ More auras can be found in the graphic section on the eA boards~ 

 

Xviii Adding Custom Maps 
~Below, is a guide that will show you the steps clearly, with pictures on how to add custom maps to your 

server! 

Adding Custom Maps PDF|Tools - 
http://www.supportmii.com/ro1/tools/Add_Custom_Map_BUI.7z 

 

Xix Adding Custom Items RagRE (Long Way) 

For this section we will concentrate on adding custom items for RagRe the long way for now, so you 
know how implementing customs in RagRE is like. Sometime in the future, I will incorporate a new 
section for the easy way to add multiple customs fast. Remember, for this tutorial, we are dealing 
with lua files, so there is no reason to compile into lub files. 

Too make this guide to add customs easy, we will be using an example since it’s easier to learn with 
examples! 

Download the Custom item Example we will use to add to your server/client files below: 

Custom Item Example - http://www.green-peach.com/download.php?file=Wings%20-
%20Fairy_Wings%20[ToZorMan] 

The above link we will use to add just one item from the pack, since the rest are just recolors. The one 
we will use for this guide will be “Black_Fairy_Wings” 



 

 
Once downloaded, just extract “Black_Fairy_Wings” folder onto your desktop 
We will now proceed to add this custom to be fully functional on our server and client 
 
Open up the Renewal Data folder in which you downloaded previously in this tutorial (If you 
followed the order). 
Navigate to the sprite directory 
Create a new directory called “¾ÆÀÌÅÛ” 
So the directory should look like data>sprite>“¾ÆÀÌÅÛ 
 
In “¾ÆÀÌÅÛ  folder, you will put the drop sprites in that folder 
So copy the sprite/act file from our Black_Fairy_Wings, Drop Folder 
And Paste them into the directory we created 

 

 
 

Next, we will add the texture, item icon and collection icon into our client files. 
Now navigate in our data folder to data>texture>À¯ÀúÀÎÅÍÆäÀÌ½º 
Create a new folder called item and another new folder called collection 
So we should have directories for  
data>texture>À¯ÀúÀÎÅÍÆäÀÌ½º>item and 
data>texture>À¯ÀúÀÎÅÍÆäÀÌ½º>collection 

Now, switch to our custom and copy the image from the collection folder into the collection folder in 
our data folder, and do the same for the item 



 

 

 

 We are done with that, now go to the sprite folder again, data>sprite and create a new folder called 
“¾Ç¼¼»ç¸®” 
So the directory should be, data>sprite>¾Ç¼¼»ç¸® 
Create new directories, ¿© and another new folder called ³². (Female and Male respectively) 
So the directories should look like the following: 

data>sprite>¾Ç¼¼»ç¸®>¿© 
data>sprite>¾Ç¼¼»ç¸®>³² 

Head back to our custom and copy the  



 

¿©_Black_Fairy_Wings.spr 
¿©_Black_Fairy_Wings.act  
 
into the “data>sprite>¾Ç¼¼»ç¸®>¿©” 

And copy the 
 
³²_Black_Fairy_Wings.spr 
³²_Black_Fairy_Wings.act 
 
into the “data>sprite>¾Ç¼¼»ç¸®>³²” 

Once done with that, we can finally start working on the text documents to add the custom in. 

We will first edit the “idnum2itemdesctable.txt” located in the root of your data folder. This 
document deals with adding descriptions for your custom item, when you right click your item 
ingame, the description will show.  
 
Now first, choose an ID you wish to give this custom item. I would recommend anything from 
“18000-30000”. 
For this guide, I will be using “18000” for the Black_Fairy_Wings 

Go ahead and open the idnum2itemdesctable.txt file 
And your custom will look like the following: 

 

For this guide, we will just use standard descriptions, and leave out formatting of weight or color. 
Also do the same for num2itemdesctable.txt. Meaning that it should look similar to the 
idum2itemdesctable.txt file. 



 

 

Close those two files, and open up, “idnum2itemdisplaynametable.txt”. This file deal with the name of 
the item you wish to see ingame. For example, if I wish to give the ID “18000” the name Judas Rocks,  
then I would put in Judas_Rocks, and in game the name of the wings would be called Judas Rocks. 

Anyway, the syntax is ID#NAMEofITEM# 



 

 

Do the same for num2itemdisplaynametable.txt file 

 

Save and close both those files, and open up our last text file to edit which is 
“idnum2itemresnametable.txt”. This deals on how the custom item’s sprite is read by the client. So 
this is VITAL to get this right. 



 

Our syntax again for this document is  

ID#SPRITENAME# 

So for the Black_Fairy_Wings, it will look like this (You usually copy the name of the Drop Sprite): 

 

Do the same for num2itemresnametable.txt file 



 

 

Save both these files and close them. We are finish with editing these text files. 

Next up, are the lua files. Navigate to data>lua files>datainfo 
 
For this section, we will be using the lua files that came with the Renewal Data Folder 
You can open lua files with notepad if you wish 
However, I would recommend downloaded notepad++ to edit better because of the formatting 

Notepad++ - http://download.tuxfamily.org/notepadplus/5.9/npp.5.9.Installer.exe 

 
Open up, accname.lua and scroll to the end of the document 
Copy the last entry and paste it so it will look like the following: 



 

 

We will not substitute “Black_Fairy_Wings” in place of this like so: 



 

Save this file, and open up accesoryid.lua. 
Scroll to the end of the document and copy the last entry and paste it onto a new row like so: 



 

And now, we will substitute our custom in place of that like so: 
Note: For this guide, I will use Custom view ID 1000, for precaution in case KRO catches up and we 
lose that free ID space. In addition when you diff your client, you can specify how many custom view 
ids you need, which I would recommend around 3000-4000. 

 

Remember the view id for this custom which is “1000”, you will need it when we add it to the 
item_db2.txt file to add it to our server. 
Save this file and close it.  



 

Navigate to your server folder and go to server files>db and open item_db2.txt 
Scroll to the bottom of the document and copy this line: 
 
We will be using the Valkyrie Helm as a dummy entry for our custom: 
Paste this line near the bottom of your item_db2.txt as follows 

5171,Valkyrie_Helm,Valkyrie Helm,5,100000,,1000,,5,,1,0xFFFFFFFE,2,2,256,,0,1,225,{ bonus 
bMdef,5; if(isequipped(2357,2421,2524)) bonus bAllStats,1; },{},{} 
 

 
Now we will change it so our Black_Fairy_Wings will be shown 



 

 
As you can see, we change the first entry to “18000” which was the ID we chose for this item. So if 
you did @item 18000 ingame when you started your server of did “@reloaditemdb” you would get 
the item. 
Also the “1000” is our viewID, meaning that “1000” is the sprite view of the Black Fairy Wings that 
we decided in the accessoryID.lua file. 

Save this file and close it. We are done with adding our very first custom! 
Start your server up, and see if it works!  
You should now be comfortable on adding more custom items. 

NOTE: From the Black Fairy Wings entry you can see a 1 before the “0xFFFFFFFE. That “1” 
represents the number of slots. So at the moment this custom has 1 slot. Changing it to 4 would mean 
that the item will have 4 slots. 

Also, to see the number of slots ingame, you will have to edit the “itemcountslottable.txt” and follow 
the syntax. For example, to have 4 slots appear for this custom (You still have to define in the 
item_db2.txt that the custom is capable of having 4 slots) the syntax would look like the following: 

18000#4# 
 
Save the file, and once you start your server, and client again, you will see 4 card slot shadows 
available. 

NOTE 2: The “256” in the custom item entry refers to the location of the custom item. Right now it is 
set at Upper Headgear. You can replace this number with the following if you wish to have it 
equipped on another location on your character: 

512 = Middle Headgear 

256 = Upper Headgear 

1 = Lower Headgear 

16 = Armor 

2 = Weapon 



 

32 = Shield 

4 = Garment 

64 = Footgear 

8 = Accessory 1 

128 = Accessory 2 

 

Xx Adding Custom Mobs RagRE 

For this section, we will be adding one custom mob. Once done, you should be able to add as many 
custom mobs as you want. 
 
We will be adding a Boss Monster from Trickster Online 

Captain Skull - http://www.green-peach.com/download.php?file=Mob%20-
%20Captain_Skull%20[ToZorMan] 

Once downloaded, extract it onto your Desktop 
Delete the image called “Mise en Bouche” 
Delete the folder called “gif anime” (We don’t need that) 
Delete the “Card” folder as well. (In this tutorial we won’t focus on adding custom illustration of 
cards) 

Now we should have contents like this: 

 
 
 

Navigate into our data folder, and go to data>sprite> ¸ó½ºÅÍ 
Create the folder “¸ó½ºÅÍ” if you don’t have it 



 

 

Open the folder and copy the two files 

Captain_Skull.spr 
Captain_Skull.act 
 
inside the data>sprite> ¸ó½ºÅÍ folder 

 

Now, navigate into data>lua files>datainfo>npcidentity.lua file 
Scroll to the bottom of the document 
Copy and paste the last entry onto another row 



 

 

We will now substitute this with our custom mob 
Recommend to use mobIDs from 3600-8000. 
For this tutorial we will use 3600 
Remember this value since we will need to add it to your mob_db2.txt 

 

Save this file, and open data>lua files>datainfo>jobname.lua file 
Scroll to the end of the document and copy and paste the last entry onto a new row 



 

 

We will now substitute it for our custom mob 

 

Save this file, and close both lua files. Navigate to your server files 
Server files>db>mob_db2.txt 
Scroll to the end of the document, and for this mob, we will be using the MVP Drake as a dummy in 
place for our custom mob 
 
1112,DRAKE,Drake,Drake,70,326666,0,28600,22880,1,1800,2100,20,35,85,80,49,75,79,50,10,12,1,1,



 

29,0x37B5,400,620,420,360,14300,10000,504,5000,719,500,0,0,1127,600,1125,950,1135,150,1128,
400,5019,350,985,3200,1189,100,0,0,0,0,4137,1 

 

It will now look like this: 

 
As you can see, the main thing that is VITAL is the first number which is the mobID sprite which we 
decided in npcidentity.lua file. The Three names are which they are referred to. Usually it is set so 
you can do @spawn better, or look up their info easily with @mi 



 

Now have successfully added your first custom mob! 
You should be able to now add as many custom mobs as you want. 
 
Note: Not discussed in this tutorial, but to add mob skills for your custom mob if you wish, refer to 
text document “mob_skill_db.txt” and follow the format. 

Note 2: Changing stats/drops of mobs, one can refer to the syntax below: 

 

// Monster Database 
// Structure of Database : 

ID,Sprite_Name,kROName,iROName,LV,HP,SP,EXP,JEXP,Range1,ATK1,ATK2,DEF,MDEF,STR,AGI,VIT,I
NT,DEX,LUK,Range2,Range3,Scale,Race,Element,Mode,Speed,aDelay,aMotion,dMotion,MEXP,ExpPer,
MVP1id,MVP1per,MVP2id,MVP2per,MVP3id,MVP3per,Drop1id,Drop1per,Drop2id,Drop2per,Drop3id
,Drop3per,Drop4id,Drop4per,Drop5id,Drop5per,Drop6id,Drop6per,Drop7id,Drop7per,Drop8id,Drop
8per,Drop9id,Drop9per,DropCardid,DropCardper 

 

 

Xxi Adding Custom NPCs RagRE 

For this guide, we will be adding a custom npc sprite, Agav Dead. Once completed with this section, 
one will know how to add as much custom npcs. 
 
Agav Dead NPC - http://www.green-peach.com/download.php?file=NPC_Agav_Dead%20[ToZorMan] 

Extract the package onto your desktop. 
In your data folder navigate to data>sprite>npc 
Create the a new folder called npc if you don’t have it 

 



 

Copy and paste the custom npc files 
 
NPC_Agav_Dead.spr 
NPC_Agav_Dead.act 
 
inside the data>sprite>npc folder 

 

Once done, navigate to data>lua files>datainfo and open the jobname.lua file 
Navigate to the bottom of the document and copy and paste the last entry onto the next row. 
 

 



 

We will now substitute that entry for our Dead Agav npc sprite. 

 
Don’t get confused by the different syntax. 
Save the file, and open the npcidentity.lua file 
Navigate to the bottom of the document and copy and paste the last entry on to a new row 

 
We will now substitute that entry for our Dead Agav npc sprite. 



 

 

 

NOTE (From Ai4rei): There is only one catch…You cannot use IDs 126~400. 

Also, you need to use an ID beyond the latest npc ID currently 568, before 700 

Beware of putting sprites after 568, since KRO custom npcs may be released which will force you 

too redo the lua files. 

NOTE 2: You should now be able to use the npc, as well as @disguise into that NPCID you chose. 

In this case @disguise 600 will disguise me into Agav Dead. 

 

Xxii Adding Custom Weapons 

We will be using an example, since after adding one custom weapon it should be easier to add as 
many as you want! 

Custom Weapon Example - 
http://www.supportmii.com/ro1/tools/Custom%20Bow%20Archer.7z 

We will also need reference…using the sprite bible at ratemyserver 
 
Sprite Bible Reference - http://ratemyserver.net/index.php?page=riot_bible_section&section=6 

So we are adding a custom weapon for the archer branch. I recommend the following diffs NOT to be 
checked… 

Ignore Errors..(Think there are 3 of them or 2) [When you start your client ignore any errors, or 
cancel when it says setup has changed.] What we want to look for is if we equip the weapon will 
errors be reported when we try to attack. 

Anyway…Extract the contents onto your desktop 



 

 

Now, we refer to the sprite bible site to look for the archer name. 

 

So the break down is this: 

±Ã¼ö_¿©_1710 
 
*±Ã¼ö – Refers to the archer name 
*_¿© or _³² refers to female and male respectively 
*1710 (Or any other number after) refers to the custom weapon sprite, and weapon 
entry ID for item_db.txt 



 

Now that we know this, we need to find some free ids. Normally I look for entries 
after the weapon type. 

For example, open server files>db>item_db.txt 
Search for “// Bows” 
We see that 1749 hasn’t been used yet. (I haven’t really tested out what happens if 
you don’t use a freeID outsite of the bow area) 
Now, remember let’s copy an entry to use as a dummy 
 
We will use the ordinary bow  
1701,Bow,Bow,4,1000,,500,15,,5,3,0x000A0848,7,2,34,1,4,1,11,{},{},{} 
 
and add the entry 
 
1749,Custom Bow, Custom Bow,4,1000,,500,15,,5,3,0x000A0848,7,2,34,1,4,1,11,{},{},{} 
 
*Just for people who don’t know, by looking at this, it has 3 slots, only useable by archer branch 
*To show slots remember to add it to the itemslotcounttable.txt in the syntax 1749#3# 

Now that we have that, return to the Custom Bow Archer folder and let’s rename our files. 
Rename like shown, I created a new folder called item, because you can’t have two files in the same 
directory having the same name. 

 

Now, navigate to your data folder, and add these entries into your text files 
 
idnum2itemdesctable 
idnum2itemdisplaynametable 



 

idnum2itemresnametable 
num2itemdesctable 
num2itemdisplaynametable 
num2itemresnametable 

It will be mostly 1749#1749# for most of them. 
For the displaynametable it would be 1749#NameYouWantOfWep# 

Once done editing all those files, save and close them 
Now navigate to texture>À¯ÀúÀÎÅÍÆäÀÌ½º>item and paste the 1749.bmp into that folder 
Now navigate to texture>À¯ÀúÀÎÅÍÆäÀÌ½º>collection and paste the 1749.bmp into that folder 

Now navigate to data>sprite>¾ÆÀÌÅÛ and drag the the two drop files 1749.act/spr into it 
Now navigate to data>sprite>ÀÎ°£Á· 

Remember from the sprite bible: 

Directory:  /data/sprite/ÀÎ°£Á·/±Ã¼ö 
Archer weapons 
 
Meaning we create a new folder called “±Ã¼ö” 

 

Now, go inside the folder, and drag the female and male sprites inside 



 

 

We are now done adding your first custom weapon for archer. Go ingame and test it out… 
@item 1749. Remember you must be an archer branch to use these items. 
Make sure the sprite/collection/drop sprite/item is working correctly. 

Email me if you have any problems with the guide. 

 

Xxiii Adding Custom Pets 

For this guide, we will be adding multiple custom pets. 
They will be using default values, and using default feed and tames. 
To change values for attacking that will have to deal with pet_db.txt which I will past over. I will give 
you some syntax you can look over so you can do it yourself. 
Also, the src>map>pet.h should be at a value of 900 to support the amount of pets we are 
implementing. 

Pet Creator - http://meixsell.net/public/Pet%20Creator%20GUI.zip 
 

Extract the contents onto your desktop in a new folder called “Pet Creator” 
 
First,  make a copy of your mob_db2.txt in case we mess up. Our job is to remove any lines that have 
//, and any spaces. 



 

For reference, it should look similar to what the default mob_db.txt file in the Pet Creator folder looks 
like. 

For this guide, we will be implementing only the custom mob we created in the previous 
section…Captain Skull 

So the copy of the mob_db2.txt should look like this 

 

Rename “mob_db2 – Copy.txt” to “mob_db.txt” and copy and paste it and overwrite the file in the Pet 
Creator 

Now open up Pet Creator.exe 
NOTE: THE FOLLOWING IMAGES SHOULD HAVE “CREATE PATCH” TICKED 

 



 

 
 

Under Tools click Load Mob Db and select the mob_db in your Pet Creator that we overwrited 
 

 

For this guide I will start Tame ID at 25000 and start Egg ID at 26000 

 

It says 5000, but something is blocking it so it’s really 25000. 
Click the Captian Skull entry to display the info in the Mob Info Area 



 

 

I will do default settings like so: 

 

Now click tools>export 
Click Make New Folder and name it New Pets 
Press Ok to export the text documents to be added to our clientside files. 
When asked, click Text button 
Text documents will now be exported 



 

 

Now go to the “New Pets” folder that the documents were exported to. 
Open up eggs_db.txt 
Add the entry inside our item_db2.txt file (server files>db>item_db2.txt) 
Navigate to the bottom of the file and paste the entry inside the eggs_db.txt into the item_db2.txt file. 

 

Open up tames_db.txt 
Add the entry inside our item_db2.txt file (server files>db>item_db2.txt) 
Navigate to the bottom of the file and paste the entry inside the tamess_db.txt into the item_db2.txt 
file. 



 

 

Save and close those files. 
Open up the pet_db.txt in the New Pets folder 
Copy and paste the entry inside into the server files>db>pet_db.txt like so: 

 

However, looking at the others, you must add an extra “,{}” to complete the syntax.  
It will look like the following: 



 

 

Save those files, and close them. 
Now, open up the ” patch_desc.txt” in the New Pets folder 
We need to copy this entry into our  
 
idnum2itemdesctable.txt 
num2itemdesctable.txt 
 

 



 

 

Save and close both of these files 
Open patch_name.txt 
It should have contents…If not, the syntax is  

25000#Captain_Skull_Tame# 
26000#Captain_Skull_Egg# 

And paste these inside our 

idnum2itemdisplaynametable.txt 
num2itemdisplaynametable.txt 



 

 

 

 

Save and close those files. 
Open patch_sprite.txt in our New Pets folder 
In this file, you may see gibberish…Either way it is the wrong format. 

 

 
 



 

 
The correct syntax is the following: 

Custom Eggs: #µ¶¼Ó¼º¾Ë# 
 
Custom Tames: #¼öÃëÀÎºÒ¸í# 

 
Paste these lines for each incorrect entry in these text files below: 
 
idnum2itemresnametable.txt 
num2itemresnametable.txt 

Now, you are able to add as many custom pets as you want as long as its within 900 which was 
defined in the src>pet.h. 

NOTE: To change attributes for the pet, look in server files>db>pet_db.txt. 
Near the top, you will see the syntax for what each entry in the column affects. 
Pets are also affected by the server files>conf>battle>pet.conf file. 
In there, you can change how the pet behaves, like is it able to attack without an item equipped ot the 
pet. 

 

Xiv Adding Custom Diffs Manually (Custom Source Mods) 

For this tutorial, we will be adding a simple source mod. This source mod will be @identifyall. 
Usually it’s easier to just apply tortoisesvn to apply the diff. But here, I will show how to manually 
add it so you know what you are doing. Open atcommand.c since that is the file that the code will be 
placed in since it says 
 
“Index: src/map/atcommand.c” 

Index: src/map/atcommand.c 
=================================================================== 
--- src/map/atcommand.c    (revision 14676) 
+++ src/map/atcommand.c    (working copy) 
@@ -8609,7 +8609,29 @@ 
    return 0; 
} 
 
+//Identifies all items [Heaven] 
+ACMD_FUNC(identifyall) 
+{ 
+    int i,indentify; 
+    struct item it; 
 
+    nullpo_retr(-1,sd); 
+ 
+    for(i=indentify=0;i < MAX_INVENTORY;i++){ 
+        if(!sd->status.inventory[i].identify && sd->status.inventory[i].nameid){ 
+            memset(&it,0,sizeof(it)); 
+            it=sd->status.inventory[i]; 
+            pc_delitem(sd,i,it.amount,0,0); 
+            it.identify=1; 
+            pc_additem(sd,&it,it.amount); 
+            indentify++; 
+        } 



 

+    } 
+    clif_displaymessage(fd,(indentify) ? "All items was identified" : "Any item was identified"); 
+    return 0; 
+} 
+ 
+ 
/*========================================== 
  * atcommand_info[] structure definition 
  *------------------------------------------*/ 
@@ -8914,6 +8936,8 @@ 
    { "delitem",           60,60,     atcommand_delitem }, 
    { "charcommands",       1,1,      atcommand_commands }, 
    { "font",               1,1,      atcommand_font }, 
+// Heaven MODs 
+    { "identifyall",        1,60,     atcommand_identifyall }, 
}; 

When you open a .diff file or see syntax that looks like this, usually you want to look at which lines 
are added, or which lines are removed if any. 
 
“-“ Means that the line will be deleted 
“+” Means  that the line will be added 

For @identifyall, this part: 

 

+//Identifies all items [Heaven] 
+ACMD_FUNC(identifyall) 
+{ 
+    int i,indentify; 
+    struct item it; 
 
+    nullpo_retr(-1,sd); 
+ 
+    for(i=indentify=0;i < MAX_INVENTORY;i++){ 
+        if(!sd->status.inventory[i].identify && sd->status.inventory[i].nameid){ 
+            memset(&it,0,sizeof(it)); 
+            it=sd->status.inventory[i]; 
+            pc_delitem(sd,i,it.amount,0,0); 
+            it.identify=1; 
+            pc_additem(sd,&it,it.amount); 
+            indentify++; 
+        } 
+    } 
+    clif_displaymessage(fd,(indentify) ? "All items was identified" : "Any item was identified"); 
+    return 0; 
+} 
+ 

 

We would want to find a line that has similar syntax, with ACMD_FUNC(x), where x is a command like 
storage/go 
For this guide, we will add the source mod under storage code in atcommand.c 

So search for: 

ACMD_FUNC(storage) 

And we will paste the source mod after: 

return 0; 



 

} 

To paste these lines without error into the visual studio 2010, you must remove the + for each line 

The end result should look like this. I included the storage part just for reference 

 

We will now deal with: 

/*========================================== 
  * atcommand_info[] structure definition 
  *------------------------------------------*/ 
@@ -8914,6 +8936,8 @@ 
    { "delitem",           60,60,     atcommand_delitem }, 
    { "charcommands",       1,1,      atcommand_commands }, 
    { "font",               1,1,      atcommand_font }, 
+// Heaven MODs 
+    { "identifyall",        1,60,     atcommand_identifyall }, 
}; 

Find in the document atcommand.h: 

{ "rura",              40,40,     atcommand_mapmove }, 

Below it paste the following so it looks like this: 



 

 

We are now done. So make sure to recompile using visual studio 2010. 
Next, add the command into server files>conf>atcommand_athena.conf 
The command was match “atcommand_identifyall”  

It will look like the following: 

 

Meaning that, the commands are usable only with people with a Level 1 Gm account, and Level 99 gm 
account is able to use #identifyall on a person if they wish. 

So this should explain a little bit on how to add a custom diff with source code into your source files 
and server. 

 

Xv Enabling Custom Palettes 

If you downloaded the data folder, you will have complete hair style and palette pack working for all 
classes. You just need to enable it.  

Go to your server files>conf>battle>client.conf 

Find: 



 

// valid range of dye's and styles on the client 

And change it so it looks like this: 

// valid range of dye's and styles on the client 
min_hair_style: 0 
max_hair_style: 46 
min_hair_color: 0 
max_hair_color: 251 
min_cloth_color: 0  
max_cloth_color: 553 

Now just download this custom dye.txt to use on your server. It’s configured for the complete palette 
package. You just need to change its coordinates to your map. 

Custom Dye Npc - http://www.supportmii.com/ro1/tools/dye.txt 

Save the file, and place it in your server files>npc>custom folder 
Add the custom by going into server files>npc>scripts_custom.conf 

Open it up and find this line: 

//npc: npc/custom/dye.txt 

To 

npc: npc/custom/dye.txt 

You have added the dye.txt npc! 
You can follow the same format/syntax to add more npc scripts. 

 

Xvi Adding Loading Screens and Logo 

Logo goes in texture folder… 
 
The name would be scr_logo.bmp, there should already be a logo in there so you will 
know how it should look like. 



 

 

The background color should be transparent. In this picture, the magenta/pink is 
transparent. 
 
Next, the loading screens go in the texture/À¯ ÀúÀÎÅÍÆäÀÌ½º folder. The loading 
screens should be in jpg format. 
 
For example: Loading00.jpg 
Then add it in your clientinfo.xml like so: 

<?xml version="1.0" encoding="euc-kr" ?> 
<clientinfo> 
<servicetype>korea</servicetype> 
<servertype>sakray</servertype> 
<connection> 
<display>Your Server</display> 
<balloon>Your Server</balloon> 
<desc>YAY</desc> 
<address>127.0.0.1</address> 
<port>6900</port> 
<version>25</version> 
<langtype>3</langtype> 
<registrationweb></registrationweb> 
<loading> 
<image>Loading00.jpg</image> 
<image>Loading01.jpg</image> 
<image>Loading02.jpg</image> 
<image>Loading03.jpg</image> 



 

<image>Loading04.jpg</image> 
<image>Loading05.jpg</image> 
<image>Loading06.jpg</image> 
<image>Loading07.jpg</image> 
<image>Loading08.jpg</image> 
<image>Loading09.jpg</image> 
<image>Loading10.jpg</image> 
<image>Loading11.jpg</image> 
<image>Loading12.jpg</image> 
<image>Loading13.jpg</image> 
<image>Loading14.jpg</image> 
<image>Loading15.jpg</image> 
<image>Loading16.jpg</image> 
<image>Loading17.jpg</image> 
<image>Loading18.jpg</image> 
<image>Loading19.jpg</image> 
<image>Loading20.jpg</image> 
<image>Loading21.jpg</image> 
<image>Loading22.jpg</image> 
<image>Loading23.jpg</image> 
<image>Loading24.jpg</image> 
<image>Loading25.jpg</image> 
<image>Loading26.jpg</image> 
<image>Loading27.jpg</image> 
<image>Loading28.jpg</image> 
<image>Loading29.jpg</image> 
</loading> 
<aid> 
<admin></admin> 
</aid> 
</connection> 
</clientinfo> 

 

 


